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JLCooper makes no warranties, express or implied, regarding this software’s fitness for a particular
purpose, and in no event shall JLCooper Electronics be liable for incidental or consequential damages,
loss of profits, loss of data or data being rendered inaccurate, or losses sustained by third parties even if
JLCooper Electronics has been advised of the possibility of such damages.
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Installation

Connect the MCS3 USB to a USB port on your Mac or on a powered USB hub. It is not
recommended that you connect the MCS3 to a USB port on a USB keyboard or on an

unpowered hub.

Note: if you have previously installed a version of the MCS3 software earlier than 3.5,
you must uninstall it before installing this version.

After downloading and double-clicking the Install_MCS3_USB_Software.dmg file, you
should see the following window:

Installation Details
| MCS3 USB 3.5

Drag the icon labeled MCS3 USB Software over the icon labeled Applications alias
then release the mouse. This will cause the Finder to copy the MCS3 software to your
Applications folder.

MCS3 USB Software



Once the copy is complete, open the /Applications/MCS3 USB Software/ folder
and double-click on the MCS3 USB application.

MCS3 USB

If this is the first time you are installing this software, or if you are installing a newer
version, an installation dialog will appear. Click on Continue to finish the installation, or
Cancel if you want to finish it the next time you run the MCS3 USB application. The
installation must be completed before the MCS3 software will be fully functional.

Install Additional Components

Installer Messages:

Additional software components must be installed in order for the control
surface to function. This installation only takes place the first time you run
the software or after an update.

Cancel Continue




Once all the software components have been installed, click on the Finish button. A
connection will be established between the MCS3 software and the MCS3 hardware,
and you can start working with the software.

Install Additional Components

Installer Messages:

installing midi driver

installing application support

installing background application
background application installed

installing uninstaller

*** Click Finish to continue ***

Finish

Uninstalling

To uninstall run the MCS3 USB Uninstaller located in the /Applications folder.
Click on the Uninstall button to begin. When the uninstall is finished, click on the Quit
button.

If there are multiple user accounts on this Mac, there may be multiple installations of the
MCS3 software, one for each user. Each user shares the MCS3 USB application and
the MCS3 USB uninstaller, but other software components are installed separately for
each user account. For this reason, the uninstaller does not remove itself or the MCS3
USB Software folder. Before deleting either of these, please make sure that the
software has been uninstalled from all user accounts.

After uninstalling, you may notice that the MCS3 driver still appears in the Audio/MIDI
Setup ( /Applications/Utilities/ ) MIDI window. This is because the Mac OS X
tries to remember the state of your MIDI setup, even if there are changes such as
removing or powering down equipment or removing drivers.



Although the driver has no effect at this point, you can remove it from Audio/MIDI
Setup if you wish. To remove the driver, disconnect the MCS from the Mac and wait for
the driver’s icon in Audio/MIDI Setup to be dimmed as in the graphic below.
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Click on the MCS3 USB icon to select it, then hit the DELETE key on the Mac keyboard
or choose Delete from the Edit menu. Quit Audio/MIDI Setup.

The MCS3 software’s preference file is not removed by the uninstaller. It takes up
relatively little space and should have no impact on the operation of other software once
the MCS3 software is uninstalled. If you want to remove it, just delete the file ~/
Library/Preferences/com.jlcooper .MCS3USB.plist.



System Setup

The MCS3 software relies on Apple’s Universal Access to perform mouse emulation. In
order for the MCS3 software to work correctly, you must open System Preferences
and go to the Universal Access pane. Make sure “Enable access for assistive
devices” is checked then quit System Preferences.

[ Na N Universal Access
A4 | e Show All Q

When using this computer, | would like assistance with:
| Seming  Hearing Keyboard Mouse |

'H'niceﬂver: Turn VoiceOver on or off: 8fn F5
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Zoom: Turn zoom ;m or off: C#8
- Zoom in: C#=
8O0 Zoom out: "CHE- [ Options...
Display: Switch to white-on-black: ~ %8

= Black on White 'Use grayscale
_'White on Black

Enhance contrast:

> —
Normal Maximum

Reduce contrast: ~ ™03,
Increase contrast: ~ 9. )

g
{_ # Enable access for assistive devices )
“15ho in the menu bar




Introduction to the MCS3 USB Software

The MCS3 Software extends the MCS3 hardware’s ability to control various applications
running on your Macintosh™. It does this by communicating with applications via MIDI,
USB and other messaging protocols built into the Mac OS. It can also simulate mouse
clicking and dragging, keystrokes and can even emulate other control surfaces if
necessary.

Keysets

The MCS3 software uses “keysets” which are sets of various actions that are taken
when MCS3 controls are pressed or turned. Different keysets can be applied to different
applications, and the MCS3 software will choose the correct keyset for whichever
application is in the foreground. If no keyset has been created for the current foreground
application, the MCS3 will use a built in keyset called the “Default” keyset.

To create or edit MCSS3 keysets, open the application, MCS3 USB (/2pplications/
MCS3 USB Software/). To create a new keyset, choose New Keyset in the File
menu and navigate to the application that will use the new keyset. You can also use
Import Keyset from the File Menu to get an existing keyset. Keysets that ship with the
MCSS are located at /Applications/MCS3 USB Software/keysets/. You only
need to use New Keyset or Import Keyset once for a given application. After that,
keysets are stored with the MCS3 software’s preferences.

You can use Export Keyset from the File Menu to save a copy of a keyset so it can be
transported to another Mac or archived for safekeeping. You don’t need to use Export in
your daily use of the MCSS3. As previously pointed out, your changes are added to the
MCSS3 software’s preferences file automatically.

There are several sample keysets included in this package, including ones for Final Cut
Pro™ and Soundtrack Pro™.



Editing Keysets

The application presents a graphical representation of the MCS3 front panel. When you
click on an on-screen control (or move a control on the MCS3 itself), that control is
selected and information about it appears in the floating Inspector window.

Conmrol Actisrc  Emulatics-

Buik In  Keypirokes Mouse  MIDE  Special o Dulation

v Errmilite jog Whed

O e SRUTTLE
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Keyset ggm Final Cut Pro

B Apply Chamged 1o all Lipera

You can choose which keyset to edit within the MCS3 USB application using the
Keysets menu. The menu lists all keysets that you have created or imported. The name
of the currently selected keyset will be displayed at the bottom of the main window.

N R |

Keyset: ’ Final Cut Pro




The Inspector Window

The Inspector window is where all your work takes place. It displays information about
the currently selected control and contains the facilities for editing that information.

O D 0D Inspector: Play (Default Layer 1)

B Latched
Control Action:  Key Sequence: space

Buile In Keyitrokes Moute MIDI Special Erfiulatisn

Keystroke: space
Modifier Keys

| 3% | o [ -~

B Repeat while pressed Repeat [ Typing Speed

Faster

Delete Keystroke

B Apply Changes to all Layers Delete Action

The Name text box allows you to give a control a more descriptive name that describes
its precise function. In the example above, the “Play” button has been assigned an
action that starts playback from the current time indicator, so naming the button “Play
From Current Time” conveys more information than “Play”.

If the selected control is a button, then immediately below the Name you will see a
“Latched” checkbox that lets you choose between a momentary (pressing the button
turns it “on”, releasing it turns it “off”) or latched (pressing and releasing it turns it “on”
and pressing and releasing it a second time turns it “off”) behavior.



Next is a description of the action that is to take place when the selected MCS3 control
is pressed or turned while the target application is active. Below that is the area where
this action can be edited. There are a series of tabs representing the different kinds of
actions that can be performed. Clicking on one of these tabs will display controls for
editing its kind of action. The available actions are Built In, Keystrokes, Mouse, MIDI,
Special and Emulation.

i Latched

Control Action: Key Sequence: p

Built In | Keystrokes | Mouse MIDI Special Emulation

Any changes made in one of these tabs are immediately applied to the selected control.
The MCS3 software allows multiple levels of Undo, so you can easily get back to any
starting point.

Also at the bottom of the Inspector window is the Delete Action button. When pressed
it will delete the action currently assigned to the selected control. This is also undoable.

OO0 Inspector: Record (Default Layer 1)

[serName |

B Latched
Control Action: No Action Assigned

B Apply Changes to all Layers




Action Tabs

Keystrokes Tab
The MCS3 controls can be assigned to send a sequence of keystrokes to an application

just as if they were keys on the Mac keyboard. These assignments are set up in the
Keystrokes Tab.

B Latched
Control Action:  Key Sequence: Mar k

Built In Eeystrokes Mouse BAICH Special Emulation
Keystroke: |I|
Modifier Keys
| LR, mx -~
B Repeat while pressed Repeat Myplng Spead

Faster

Delete Keystroke

8 Apply Changes to all Layers

Select a control to edit, place the cursor in the Keystroke field and type a key. If you
hold down any modifier keys (command, shift, option or control) while typing this key,
the modifier checkboxes will be set up accordingly. You can also manually change the
modifier checkboxes by clicking on them.



Some key/modifier combinations may be intercepted by the operating system before
they reach the Inspector window. If this happens, just type the key without any
modifiers, then click on the appropriate checkboxes to add the desired modifiers.

To add more keystrokes to the sequence, click on the Next button and repeat the above
procedure. You can move forwards or backwards in the sequence with the Next and
Previous buttons. The Delete Keystroke button will remove the currently displayed
keystroke from the sequence.

If Repeat while pressed is checked, the keystroke (or sequence) will repeat as long as
the MCSS3 control is held down. The speed of the repeat is controlled by the Repeat/
Typing Speed slider. This slider also determines how much time there is between
keystrokes if the sequence is more than one keystroke.

If the key sequence in the example below was assigned to the STOP button, pressing
and holding STOP would be the equivalent of repeatedly typing the word “mark” until
STOP was released.

Control Action:  Key Sequence: Mark

Built I Keystrokes Mouse MID Special Ermulation

Keystroke: | M |

Modifier Keys

| 3 & 4 X B

kd Repeat while pressed Repeat/Typing Speed

Fasper

Delete Keystroke




The Keystrokes tab can vary depending on the type of MCS3 control selected. For the
Jog Wheel, different key sequences can be assigned to each direction. Click on the
Counter Clockwise or Clockwise radio button to choose which direction’s sequence to
edit.

“

In the example below, a counter clockwise turn would send a “-” and a clockwise turn

would send a “+”.
8. Inspector: Jog (Default Layer 1)

Control Action:  Key Sequence: Counter Clockwise - = Clockwise - +

Built In | Weystrokes = Mouse MIDI  Special  Emulation

@ Counter Clockwise @ Clockwise

Keystroke: | +

Modifler Keys

| 3 &l 4 [ -~

B Repeat while pressed Repeat/Typing Speed

Fasuer

Delete Keystroke

B Apply Changes to all Layers



The Shuttle Control can have a key sequence assigned not only to its counter clockwise
and clockwise directions, but also to it’s center detent. The example below implements
JKL shuttling which is used by several nonlinear video editors. In other words, the
shuttle will send a “j” when being turned counter clockwise, an “” when being turned
clockwise and a “k” when it is returned to the center position.

Control Action: Key Sequence: Counter Clockwise - j Stopped - k
Clockwise - |

Built In Keystrokes Mouse MIDI Special

@ Counter Clockwise @ Stopped © Clockwise

Modifier Keys

| s |o (e |r

B Repeat while pressed Repeat/Typing Speed

|

Faster

Delete Keystroke




Mouse Tab

The controls on the MCS3 can be made to emulate the Macintosh mouse. Buttons can
perform clicks and the Jog Wheel and Shuttle Control can perform horizontal and

vertical moves and drags.

Control Action: Horizontal Drag

Built In Keystrokes Mouse MIDI Special

Mouse Action Horizontal Drag '+

Starting Location Don't Capture =
The mouse pointer will not be repositioned before clicking.

@ Partial window name Window Name

Modifier Keys

@ Apply Changes to all Layers




The Mouse Action popup lists the actions available for the selected control. For
example, if the Jog Wheel is selected the popup would look like this:

Mouse Action

Horizontal Mowve
Starting Location Wertical Mowe

Harizontal Drag
Vertical Drag

The Starting Location popup lets you choose where the click, move or drag will
originate.

Mouse Action Horizontal Drag |5

e T v Don't Capture
Relative to Window Top Left
Relative to Window Top Right
Relative to Window Top, Percentage of Width
Relative to Window Bottom Left

Relative to Window Bottom Right

Relative to Window Bottom, Percentage of Width
B FPartial window Relative to Screen Top Left

The mouse pointer

If you choose Don’t Capture, the mouse action will always begin at the current location
of the Mouse pointer. If you choose any other option, you will be prompted to pick a
point in one of the target application’s windows. The options in this menu determine how
the MCS3 will find that point in the event that the destination window has been resized
or moved.

Option When Destination Window is
Resized or Moved

Relative to Window Top Left The start point will stay the same
distance from the top left corner of
the window.

Relative to Window Top Right The start point will stay the same
distance from the top right corner of
the window.

Relative to Window Top Percentage of Width The start point will stay the same
distance from the top of the window,
but it’s horizontal position will be a
percentage of the window’s width..




Option When Destination Window is
Resized or Moved

Relative to Window Bottom Left The start point will stay the same
distance from the bottom left corner
of the window.

Relative to Window Bottom Right The start point will stay the same
distance from the bottom right
corner of the window.

Relative to Window Bottom Percentage of Width | The start point will stay the same
distance from the bottom of the
window, but it’s horizontal position
will be a percentage of the
window’s width..

Relative to Screen Top Left The start point will stay the same
distance from the top left corner of
the screen, no matter what the size
or position of the window.

For example, let’s say that a particular application has an onscreen shuttle slider in the
lower right hand corner of it’s Timeline window, and the center of that slider is 100 pixels
from the right of the window and 20 pixels from the bottom of the window. When the
window is resized, the slider stays at 100 pixels from the right and 20 pixels from the
bottom of the window.

Suppose the only way to access this program’s shuttle function is by dragging this slider
left or right. You could program the MCS3 Shuttle Control to do a horizontal drag
starting at 100, 20 Relative to Window Bottom Right.



Once you have chosen from the Starting Location popup, you will be prompted to
actually pick the starting point.

Built In Keystrokes | Mouse | MIDI Special

Mouse Action Horizontal Drag  |'%

£

Starting Location Relative to Window Bottom ... |

Make sure destination application is visible in background
and click Capture button. Position mouse pointer over
desired starting point and hit <COMMAND K> to complete

capture.

Make Sure the target application is open in the background, and that the destination
window is visible. Hit the Capture button then position the mouse pointer over the
desired starting point and type <COMMAND K>.

o

Namrse | I

Corrol Action:  Harigontal Deag &1 0, O from bottam right of “[rull® ﬁ Hi: 113,10

Builtbn  Keyitroked - Mougs | MIDI  Specisl

Mouse Action
Searring Location Reslarsee 10 Windos Bomom Ragin

Move mouse pointer to 0, O from bostom right of window
Snedl]” bafore clicking

R

Mo ier Keys

m X

B Apply Changes to all Layers




The Inspector window will be updated to show the window name and coordinates
where the click, drag or move should take place.

Control Action:  Horizontal Drag at 42, 95 from bottom right of "Canvas:
Glacier Park 2009 in Glacier 2009"

Built In  Keystrokes Mouse = MIDI  Special

Mouse Action Horizontal Drag %
Starting Location Relative to Window Bottom Right ' 5

Move mouse pointer to 42, 95 from bottom right of window

"Canvas: Glacier Park 2009 in Glacier 2009" before clicking

@ Partial window name |Canvas: Clacier Park 20089 in Clacl

Modifier Keys

From now on, whenever you are in the target application and use the assigned control,
it will move the destination window to the front, then click, move or drag at the selected
location.

Once a window name and mouse location has been captured, you have the option of
using a partial window name. This is useful in applications like Final Cut Pro, where the
Canvas Window’s title always starts with the word "Canvas" but the rest of the window
title changes depending on what you're editing. Normally, the MCS3 tries to find a
window with the exact name as the window where the click was first captured, but if the
window name has changed, it will fail. If you choose to have the MCS3 just look for the
word Canvas in Final Cut Pro it will always find the Canvas Window, even if the exact
name of the Canvas Window changed since the click was captured.

To use the partial name feature, click on the Partial Window Name checkbox. In the
text box on the right, change the full window name to the partial name you want the
MCS3 to use.

B Partial window name |Canvas: Glacier Park 2009 in Glaci
DE——



MIDI Tab

An MCS3 can be made to appear as a MIDI device to MIDI applications. Any MCS3
control can be programmed to send and respond to a MIDI message.

il

Inspector: Play (Default Layer 1)

b4 Latched

Control Action: No Action Assigned

Built In

Keystrokes Mouse | MIDI | Special Emulation

& Mone @ Native MIDI @ Custom MIDI

There are three radio buttons for choosing the type of MIDI message to assign.

None

No MIDI message for the selected control. If some other type of
action has already been assigned, the None button will be selected.
Clicking on the None button will delete the currently assigned
action.

Native MIDI

Native MIDI actions send and respond to the same messages as
the MIDI version of the MCS3. You would typically use this setting
with an application which directly supports the MCS3 protocol. It
could also be used with an application that has a MIDI “Learn”
feature.

For convenience, choosing Set all Controls to Native MIDI in the
Actions menu will assign Native MIDI actions to all of the MCS3
controls on all layers in the current keyset.

Custom MIDI

Custom MIDI actions send and respond to user defined MIDI
messages.




When Custom MIDI is chosen, more controls will become visible for editing the custom
messages.

Control Action: Custom MIDI: 80 01 wvalue

Built In Keystrokes Mouse | MIDI | Special Emulation

@ None @ Native MIDI & Custom MIDI

MIDI Message Type Mote Off

MIDI Channel |1 | 2]

1st Data Byte I:l a B Follows Control's Value

2nd Data Byte D & Follows Control's Value

The MIDI Message Type popup lets you choose any of the basic MIDI messages
except for system exclusive and MIDI Time Code.

MIDI Message Type |« MNote Off
Mote On
MIDI Channel Poly Key Pressure
Control Change
1st Data Byte Program Change
Mono Key Pressure

2nd Data Byte Pitch Bend

Song Select
Tune Request

Start
Continue
Stop

System Reset

B Apply Changes to all Layers

The first group of messages in the popup include a MIDI channel. If you choose one of
these message types, a channel editor appears. You can either type or use the up and
down arrows to set the channel. This editor accepts values from 1 through 16.



All MIDI messages except for system exclusive are either one, two or three bytes long.
The first byte always is the message type, called the status byte. If there is a MIDI
channel, it is embedded in the status byte. The bytes following the status byte, if any,
are referred to as data bytes and contain additional information such as note numbers,
velocities, control values, etc...

If you choose a message type that is more than one byte long the 1st Data Byte ( and
possibly the 2nd Data Byte) editor appears. You can set the data byte’s value by typing
or using the up/down arrows. The editor accepts values from 0 through 127.

Instead of setting an absolute value for a data byte, you can check the Follows
Control’s Value box. In this case, the value of that data byte is determined by the state
of the MCSS3 hardware control this message is assigned to. In other words, if you
assigned a Custom MIDI Message to the Jog Wheel and the 2nd data byte was set to
Follows Control’s Value, a number representing the movement of the Jog Wheel
would be inserted as the 2nd data byte of the custom message. For MCS3 buttons, a
value of 127 will be inserted for button presses, and 0 for button releases.

Following are some samples of the MIDI Tab’s appearance for various message types.

MIDH Message Type Program Change

MIDI Channel  [3 | B
1st Data Byte i Follows Control's Value

MIDI Message Type Pitch Bend

MIDI Channel  [3 | 8

1st Data Byte & Follows Control's Value
2nd Data Byte a B Follows Control's Value

MID Message Type Stop




To access the MCS3’s MIDI messages in your MIDI application, connect your
application’s MIDI input and output ports to the ports labeled “MCS3”. Depending on the
application, the ports may be labeled “MCS3 USB”. The exact method for connecting to
MIDI ports varies from application to application. Consult the manuals of the MIDI
applications you are using to learn how to do this.



Emulation Tab

The MCS3 software has the ability to emulate other MIDI based control surfaces. This
feature is useful if you are using the MCS3 with an application which doesn’t directly
support the MCS3, but which supports one of these other control surfaces.

You can set any control on the MCSS3 to emulate a control on one of these control
surfaces using the Emulation Tab. The Emulation Tab is not available until you turn on
Emulation in the Emulation Menu. Here you can choose None, Mode A, or Mode B.
Mode A and B represent two different control surfaces. Which one you choose depends
on the application you are using with the MCS3. More on this later.

Keysgls 4

The contents of the Emulation Tab varies depending on the type of MCS3 control that
is selected. This is what you will see at first if you select a button.

Built In Keystrokes Mouse MIDI Special | Emulation

B Emulate this control:
Control Group:  « Transport L]
FKey
Cursor
Bank Change
Assignment
Utilities
Group
SMFPTE/Beats
Flip
Global View
Name /Value
Modifiers
Automation
User Switch
Miscellaneous
Record /Ready
Sole
Mute
Select
Pot Switch
T —




The Control Group popup lists the basic categories of controls that can be emulated by
the selected MCS3 control. Checking Emulate this control: or choosing from the
Control Group popup will assign an Emulation action to the selected control. It will also
display either a second popup or a numerical editor for choosing which control in the
group to emulate.

For some control categories, such as Transport, the individual controls in that category

have names, such as Rewind, Fast Forward, Stop, Play and Record. For these
categories a second popup will list the control names.

& Emulate this control:

Control Group: Transport

Control Name: |+ Rewind
Fast Forward
Stop
Play
Record

For other categories, such as F-Keys, the controls are just numbered. For these
categories a numerical editor will appear. This allows you to either type or use up/down
arrows to set the control number.

& Emulate this control:

Control Group: FHey

ChannelfControl Number I:I a

The Jog Wheel only has one choice, Emulate Jog Wheel.

&4 Emulate Jog Wheel

You cannot assign Emulation actions to the Shuttle Control because none of the
emulated control surfaces have this function.



For convenience, choosing Set all Controls to Emulation in the Actions menu will
assign Emulation Actions to many of the MCS3 controls on all banks in the current
keyset. Some MCS3 controls do not correspond to any controls on the emulated control
surfaces, so those controls are left unassigned.

The following assignments are made when Set all Controls to Emulation is chosen.
The same assignments are made to all four layers

MCS3 Control

Rewind
Fast Forward
Stop
Play
Record
Jog

W1

w2
W3
w4
W5

F1

F2

F3

F4

F5

F6

Up
Right
Down
Left

Assignment

Emulation- transport: rewind
Emulation- transport: fast forward
Emulation- transport: stop
Emulation- transport: play
Emulation- transport: record
Emulation- jog

Emulation- automation: read/off
Emulation- automation: write
Emulation- automation: trim
Emulation- automation: touch
Emulation- automation: latch
Emulation- fkey: 1

Emulation- fkey: 2
Emulation- fkey: 3
Emulation- fkey: 4
Emulation- fkey: 5
Emulation- fkey: 6
Emulation- cursor: up
Emulation- cursor: right
Emulation- cursor: down
Emulation- cursor: left



Special Tab

The Special Tab is a collection of actions that don’t easily fit into other categories.

Built In

@® None

The choices are:

Keystrokes Mouse MIDI Special Emulation

O Layer 1 Selector @ Developer

@ Layer 2 Selector

@ Layer 3 Selector

@ Layer 4 Selector

None

No Special Action for the selected control. If some other type of
action has already been assigned, the None button will be selected.
Clicking on the None button will delete the currently assigned action.

Layer Selectors

When assigned to an MCS3 button, that button can be used to
switch between layers. When a Layer Selector Special Action is
assigned to an MCS3 button, that assignment is automatically copied
to that button on all layers.

These options will not appear when the Jog Wheel or Shuttle Ring
are selected.

Developer Mode

This is intended for use with applications which directly support the
MCS3. This action uses messaging protocols built into Mac OS X to
communicate with these applications.

You normally wouldn’t use this mode unless you knew that an
application you were using supported it. 3rd party developers who
support this mode would typically ship MCS3 keysets along with their
applications.

For convenience, choosing Set all Controls to Developer Mode in
the Actions menu will assign Developer Mode Special Actions to
all of the MCS3 controls on all layers in the current keyset.




Built In Actions Tab

The built in actions are actions that are predefined for specific applications. When you
choose a keyset, the built in actions appropriate to that keyset’s application are
displayed. If no built in actions have been defined for the current application, the display
will be blank.

The built in actions are presented in two columns. The left hand column lists basic
categories and the right hand column lists the actual actions. Clicking on a category in
the left hand column will change the list of actions displayed on the right. Double-click
an action name to assign it to the selected MCS3 control.

Control Action:  Built In- Mark: Add Marker

Built In | Keystrokes Mouse MIDI Special Emulation

Built In Commands for Final Cut Pro:

Rewind and Fast Forward 4 Add Marker

Color Corrector 3-way v Clear In

Color Cor 3-way w/Effect L... Clear In and Out
Clear Qut

Audio Delete All Markers

Capture Delete Marker

Compositing Edit Marker...

Display Extend Marker

Editing Mark Audio In

Expart Mark Audio Out

Favorites Mark Clip

Files Mark In

Filters and Effects Mark Qut

Coto Mark Selection

Import & Mark Video In

Mark v Mark Video Out

Most of the categories and actions correspond to the keyboard shortcuts listed in the
target application's manual. However, there are also actions defined by JLCooper that
are not simple keyboard shortcuts. These actions will always appear at the beginning of
the list, and there will be a separator line between them and other built in actions.



Final Cut Pro™ Support
Final Cut Pro™ and Control Surfaces

With FCP version 5 some support for MIDI control surfaces was added. Unfortunately,
only audio parameters and transport functions are controllable via MIDI. Fortunately, the
MCS3 software not only emulates the supported control surfaces, it also can control
many other parameters in FCP.

The MCS3 has a large advantage over other control surfaces when used with Final Cut
Pro because it is not limited to just the functions included in Final Cut’s MIDI control
surface support. With its built in functions and the ability to emulate the mouse and
keyboard coupled with FCP’s control surface support, virtually every function in Final
Cut Pro can be controlled with the MCS3.

Final Cut Pro™ Shuttle

The FCP Built In Shuttle command works equally well in the Timeline, Canvas, Viewer
and Log and Capture windows.

Using the MCS3 with Final Cut Pro™

To use the MCS3 with FCP, first run the MCS3 USB application and import the Final Cut
keyset provided by JLCooper. Now run Final Cut and open the Control Surfaces dialog
from the Tools menu. Click on the “+” button to add a control surface and choose
Mackie Control. Then choose MCS3 USB - MCS3 for the input connection and output
connections. Click OK to exit the dialog.

Final Cut requires the Audio Mixer (Tools Menu) to be open in order for control surface
support to be active. You might want to save a window layout that has the Audio Mixer
open.

As mentioned earlier, in order for Mouse Emulation to work, the Accessibility System
Preferences most be set correctly. This is important to the FCP keyset since some of
the FCP Built In Commands use Mouse Emulation. Please see the section of this

manual entitled System and Software Setup if you are unsure about these settings.



The MCS3 Final Cut Pro Keyset

The MCS3 Final Cut Pro keyset uses a combination of emulated controls, mouse
emulation, keystrokes and built-in commands. It is fully customizable using the
techniques presented in this manual, so you can easily adapt it to your working style.

The keyset uses three of the four layers, with some duplication in each layer where it
makes sense. The layers are selected with F1, F2 and F3.

Here are the control assignments in the current version of the FCP keyset:

Layer 1 MCS3 Control Assignment
Rewind Emulation- transport: rewind
Fast Forward Emulation- transport: fast forward
Stop Emulation- transport: stop
Play Emulation- transport: play
Record Built In- Capture: Batch Capture...
Jog Emulation- jog
Shuttle Built In- Jog and Shuttle: Shuttle
Wi1 Built In- Mark: Mark In
W2 Built In- Mark: Mark Out
W3 Built In- Goto: Go to In Point
W4 Built In- Goto: Go to Out Point
W5 Built In- Mark: Add Marker
W6 Built In- Goto: Go to Previous Marker
W7 Built In- Goto: Go to Next Marker
F1 Layer 1 Selector
F2 Layer 2 Selector
F3 Layer 3 Selector
F4 Built In- Windows: Show Timeline




F5 Built In- Windows: Show Canvas
F6 Built In- Windows: Show Viewer
Up Key Sequence: Home
Right Built In- Other: Right
Down Key Sequence: End
Left Built In- Other: Left

Layer 2 MCS3 Control Assignment
Rewind Emulation- transport: rewind

Fast Forward

Emulation- transport: fast forward

Stop Key Sequence: Esc

Play Emulation- transport: play
Record Built In- Capture: Capture Now
Jog Emulation- jog

Shuttle Built In- Jog and Shuttle: Shuttle
Wi1 Built In- Mark: Mark In

W2 Built In- Mark: Mark Out

W3 Built In- Goto: Go to In Point

W4 Built In- Goto: Go to Out Point
W5 Built In- Mark: Add Marker

W6 Built In- Goto: Go to Previous Marker
W7 Built In- Goto: Go to Next Marker
F1 Layer 1 Selector

F2 Layer 2 Selector

F3 Layer 3 Selector

F4 Built In- Windows: Show Browser




F5 Built In- Windows: Show Favorites
F6 Built In- Windows: Show Effects
Up Built In- View Menu: Zoom Out
Right Built In- Goto: Go to Next Edit
Down Built In- View Menu: Zoom In
Left Built In- Goto: Go to Previous Edit
Layer 3 MCS3 Control Assignment
Rewind Emulation- transport: rewind

Fast Forward

Emulation- transport: fast forward

Stop Emulation- transport: stop

Play Emulation- transport: play

Record Built In- Capture: Batch Capture...
Jog Emulation- jog

Shuttle Built In- Jog and Shuttle: Shuttle

Wi1 Built In- Mark: Mark In

W2 Built In- Mark: Mark Out

W3 Built In- Goto: Go to In Point

W4 Built In- Goto: Go to Out Point

W5 Built In- Mark: Add Marker

W6 Built In- Goto: Go to Previous Marker
W7 Built In- Goto: Go to Next Marker

F1 Layer 1 Selector

F2 Layer 2 Selector

F3 Layer 3 Selector

F4 Built In- Capture: Log and Capture...




F5

Built In- Windows: Show Tool Bench

F6 Built In- Windows: Show Audio Meters
Up Emulation- cursor: up

Right Emulation- cursor: right

Down Emulation- cursor: down

Left Emulation- cursor: left




Final Cut Pro X™ Support

Unlike Final Cut Pro 7, FCP X includes no built-in support for control surfaces. However,
the MCS3 is still quite useful with FCP X because JLCooper has converted all of the
FCP X keyboard shortcuts into MCS3 Built-In Commands.

JLCooper has included a Final Cut Pro X keyset which has assigned Built-In
Commands to many of the MCS controls, but which still leaves room for customization.

Following is a list of the FCP X keyset assignments.

MCSS3 Layer 1 FCP X MCS3 Layer 2 FCP X
Rewind Play Reverse Rewind
Fast Forward Play Forward Fast Forward
Stop Stop Stop
Play Play Play
Jog Jog Jog
Shuttle Shuttle Shuttle
w1 Set Selection Start WH1
w2 Set Selection End w2
w3 Add Marker w3
w4 Delete Marker w4
W5 Go To Previous Marke W5
W6 Go To Next Marker W6
F1 Select Layer 1 F1 Select Layer 1
F2 Select Layer 2 F2 Select Layer 2
F3 Event Browser F3 Project Library
F4 Timeline F4 Timeline Index
F5 Inspector F5 Color Board
F6 Event Library F6 Audio Enhancements
Up Go To Beginning Up
Right Go Forward 10 Frame Right
Down Go To End Down

Left Back 10 Frames Left



Soundtrack Pro™ Support

Setting up the MCS3 for use with Soundtrack Pro is almost identical to setting up for
Final Cut Pro.

Open the MCS3 USB application and Import the Soundtrack Pro keyset or create a
keyset of your own. If you create your own, start by setting the Emulation Mode to A
then choosing Set All Controls to Emulation from the Actions menu. Later on you can
customize this keyset with built-in commands, key sequences and mouse actions.

The next time you run Soundtrack Pro, open the Preferences dialog from the
Soundtrack Pro menu then go to the Control Surfaces panel. Click on the “+” button to
add a control surface and choose Mackie Control. Choose MCS3 USB - MCS3 for the
input connection and output connections. Click OK to exit the dialog.

The Soundtrack Pro Keyset

The Soundtrack Pro keyset is a combination of emulated actions, keystrokes and built in
commands. It uses three layers with some duplication between layers. As with all other
MCSS3 keysets, it is fully customizable.

F1 - F3 function as layer selectors. In Layer 1, F4 - F6 are used to toggle various panes
on and off. In Layer 2, F4 - F6 toggle different HUD displays and in Layer 3, F4 - F6
Tabs in various panes. Activating a Tab also activates the pane it is in. Once a pane is
activated in this fashion, the left and right VStick in Layer 3 can be used to move
between Tabs in the currently active pane.

In Layer 1 the VStick is used for zooming and in Layer 2 it is used for navigating the
timeline.

Layer 1 MCS3 Control Assignment
Rewind Move Back
Fast Forward Move Forward
Stop Stop
Play Play
Record Record
Jog Jog
w1 Insert Time Marker
w2 Add Region Marker for Selection
w3 Add Time Markers at Beg. & End
w4 Insert Beat Marker
W5 Goto Previous Marker

W6 Goto Next Marker



Layer 1

Layer 2

Layer 3

MCS3 Control

F1

F2

F3

F4

F5

F6

Up
Right
Down
Left

MCS3 Control
Rewind
Fast Forward
Stop
Play
Record
Jog
F1
F2
F3
F4
F5
F6
Up
Right
Down
Left

MCS3 Control
Rewind
Fast Forward
Stop
Play
Record
Jog
F1
F2

Assignment
Layer 1
Layer 2
Layer 3
Toggle Left Pane
Toggle Lower Pane
Toggle Right Pane
Zoom Out Vertical
Zoom In Horizontal
Zoom In Vertical
Zoom Out Horizontal

Assignment
Move Back
Move Forward
Stop
Play
Record
Jog
Layer 1
Layer 2
Layer 3
Toggle Multipoint Video HUD
Toggle Sound Palette
Toggle Timecode HUD
Goto Beginning
Forward One Frame
Goto End of Cycle Region
Back One Frame

Assignment
Move Back
Move Forward
Stop
Play
Record
Jog
Layer 1
Layer 2



Layer 3

MCS3 Control
F3
F4
F5
F6
Right
Left

Layer 3
Video Tab
Mixer Tab
Details Tab
Next Tab
Previous Tab

Assignment



GarageBand™ Support

Open the MCS3 USB application and Import the GarageBand Keyset. Later on you can
customize this keyset with built-in commands, key sequences and mouse actions.

The GarageBand Keyset

The GarageBand keyset is a combination of keystrokes and built in commands. It uses
two layers with some duplication between layers. As with all other MCSS3 keysets, it is
fully customizable.

F1 - F3 function as layer selectors. In Layers 1 and 2, F4 - F6 are used to show and
hide various panes and windows. In Layer 2, F4 - F6 toggle different HUD displays and
in Layer 3, F4 - F6 Tabs in various panes.

In Layer 1 the VStick is used for navigating the timeline, and in Layer 2, the VStick Up
and Down are used for zooming.

In Layer 1, the Jog Wheel is used for jogging, and in Layer 2 it is used to adjust the
Master Volume.

Layer 1 MCS3 Control Assignment
Rewind Rewind
Fast Forward Fast Forward
Stop Stop
Play Play
Record Start / Stop Recording
Jog Jog
w1 Show Chord / Tuner Mode
w2 Show Time Mode
w3 Show Measures Mode
w4 Show Tempo Mode
W5 Cycle Region on/Off
W6 Metronome On/Off
w7 Count in On/Off
F1 Layer 1
F2 Layer 2
F3 Layer 3
F4 Track Info
F5 Editor
F6 Loop Browser

Up Goto Beginning



Layer 1 MCS3 Control Assignment

Right Forward
Down Goto End
Left Back
Layer 2 MCS3 Control Assignment
Rewind Rewind
Fast Forward Fast Forward
Stop Stop
Play Play
Jog Master Volume
F1 Layer 1
F2 Layer 2
F3 Layer 3
F4 Media Browser
F5 Onscreen Keyboard
F6 Musical Typing Window
Up Zoom QOut

Down Zoom In



iMovie™ Support

Open the MCS3 USB application and Import the iMovie Keyset. Later on you can
customize this keyset with built-in commands, key sequences and mouse actions.

The iMovie Keyset

The iMovie keyset is a combination of keystrokes and built in commands. It uses two
layers with some duplication between layers. As with all other MCS3 keysets, it is fully

customizable.

F1 - F3 function as layer selectors. In all Layers, F4 - F6 are used to show and hide
various panes and windows. In each layer the Play button is assigned a different
variation of the Play command.

W1 - W7 are assigned various editing tasks in Layer 1.

Layer 1 MCS3 Control

Rewind
Fast Forward
Stop
Play
Jog

w1

w2

w3

w4

W5

W6

w7

F1

F2

F3

F4

F5

F6
Right
Left

Assignment

Reverse

Forward

Stop

Play

Jog

Select All

Mute Clip

Split Clip

Undo

Redo

Enter / OK/ Done
Cancel

Layer 1

Layer 2

Layer 3

Clip Adjustments Panel
Video Panel
Audio Panel
Forward 1 Frame
Back 1 Frame



Layer 2

Layer 3

MCS3 Control
Rewind
Fast Forward
Stop
Play
Jog
w6
w7
F1
F2
F3
F4
F5
F6

MCS3 Control
Rewind
Fast Forward
Stop
Play
w6
w7
F1
F2
F3
F4
F5
F6

Assignment
Reverse
Forward
Stop Full Screen
Play Full Screen
Extend Selection
Enter / OK / Done
Cancel
Layer 1
Layer 2
Layer 3
Clip Trimmer
Edit Trimmer
Crop / Rotate / Ken Burns

Assignment
Reverse
Forward
Stop
Play from Beginning
Enter / OK / Done
Cancel
Layer 1
Layer 2
Layer 3
Keywords Window
Titles Pane
Transitions Pane



Logic™ Support

Open the MCS3 USB application and Import the Logic Pro keyset or create a keyset of
your own. If you create your own, start by setting the Emulation Mode to B then
choosing Set All Controls to Emulation from the Actions menu. Later on you can
customize this keyset with built-in commands, key sequences and mouse actions.

The next time you run Logic Pro, open the Preferences dialog from the Logic Pro menu
then go to Control Surfaces > Setup. Click on Install in the New menu at the top of left
of the window. Choose Logic Control from the list of control surfaces and click on Add.
Choose MCS3 for the Out Port and Input. Close the Setup Dialog dialog.

The Logic Keyset

The Logic keyset is a combination of emulation, keystrokes and built in commands. It
uses one layer.

W1 - W7 are used to set the automation mode and to create and locate to markers. F1 -
F6 are used to select Screensets 1 - 6.

The VStick is used for track selection and zooming.

Layer 1 MCS3 Control Assignment
Rewind Rewind
Fast Forward Fast Forward
Stop Stop
Play Play
Record Record
Jog Jog
w1 Selected Track - Read / Off (Emulation- autc
w2 Selected Track - Touch
w3 Selected Track - Latch
w4 Selected Track - Write
W5 Create Marker
w6 Previous Marker
w7 Next Marker
F1 Screenset 1
F2 Screenset 2
F3 Screenset 3
F4 Screenset 4

F5 Screenset 5



Layer 1 MCS3 Control Assignment

F6 Screenset 6
Up Select Previous Track
Down Select Next Track

Right Zoom In/Out



Nuendo™ Support

Open the MCS3 USB application and Import the Nuendo keyset or create a keyset of
your own. If you create your own, start by setting the Emulation Mode to A then
choosing Set All Controls to Emulation from the Actions menu. Later on you can
customize this keyset with key sequences and mouse actions.

The next time you run Nuendo, open the Device Setup dialog from the Devices menu
then go click on Mackie Control under Remote Devices. Choose MCS3 USB MCS3 for
the MIDI Output and MIDI Input. Hit OK to accept your settings and close the Setup
Dialog.

The Nuendo Keyset

The Nuendo keyset is a combination of emulation and keystrokes. It uses three layers
with some duplication between layers.

F1 - F3 are layer selectors. F4 - F6 are used to open and close various windows and
dialog boxes in all three layers.

W1 - W6 control automation modes, markers, locating events, OK’ing, Canceling, and
Closing windows, with slight differences between layers.

The VStick is used for track selection and zooming with some differences between
layers.

Layer 1 MCS3 Control Assignment
Rewind Rewind
Fast Forward Fast Forward
Stop Stop
Play Play
Record Record
Jog Jog
w1 Read
w2 Write
w3 Markers
w4 Previous Marker
W5 Next Marker
w6 OK/Enter
w7 Cancel
F1 Layer 1
F2 Layer 2

F3 Layer 3



Layer 1

Layer 2

Layer 3

MCS3 Control

F4

F5

F6

Up

Right

Down

Left

MCS3 Control
Rewind
Fast Forward
Stop
Play
Record
Jog
w1
w2
w3
w4
W5
W6
w7
F1
F2
F3
F4
F5
F6
Up
Right
Down
Left

MCS3 Control
Rewind
Fast Forward
Stop
Play

Assignment
Transport Panel
Mixer Window
Video
Select Previous Track
Zoom Timeline In
Select Next Track
Zoom Timeline Out

Assignment
Rewind
Fast Forward
Stop
Play
Record
Jog
Read
Write
Markers
Previous Event
Next Event
OK/Enter
Cancel
Layer 1
Layer 2
Layer 3
Project Setup
VST Connections
Tempo Track
Select Previous Track
Zoom Track In
Select Next Track
Zoom Track Out

Assignment
Rewind
Fast Forward
Stop
Play



Layer 3

MCS3 Control
Record
Jog
w1
w2
w3
w4
w5
w6
w7
F1
F2
F3
F4
F5
F6
Up
Down

Assignment
Record
Jog
Read
Write
Markers
Previous Marker
Next Marker
OK/Enter
Close
Layer 1
Layer 2
Layer 3
Organize Workspaces
Browser
Pool
Select Previous Track
Select Next Track



